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Objetivos

Al término de este curso - taller el participante

1. Pondra en practica principios y herramientas en que se basan
los mapas mentales con el fin de organizar su pensamiento de
manera mas creativa y eficaz, impulsar su capacidad de
aprendizaje, favorecer diversas funciones de su inteligencia y

aplicarlos en diversos aspectos de su trabajo y vida personal.

disefiar mapas mentales a través de este programa.

Asimismo, aplicara la tecnologia del Sistema Mind Manager para
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mentales 1.2.4. Condiciones éptimas para las sesiones de trabajo 11
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1. Fundamentos de los mapas mentales

1.1. Acerca de los mapas mentales

“El cerebro humano es un telar encantado en donde millones
de velocisimas lanzaderas van tejiendo un disefic que
continuamente se disuelve, un motivo-que tiene siempre un
significado por mas que éste jaméas perdure y no sea mas que
una cambiante armonia de subdisefics. Es lo mismo que si la
Via Lactea se entregara a una especie de danza cosmica.”
Tony Buzan, creador de fos mapas mentales (1996: 37)

Esta metafora ilustra el pensamiento irradiante, una capacidad de percepcion multidireccional que tiene el
cerebro humano para procesar diversas informaciones en forma simultdnea. Es la forma natural vy
virtualmente automatica en que ha funcionado siempre el cerebro humano.”

1.1.1. ; Qué es un mapa mental?

Para Tony Buzan, un mapa mental es:
“Una expresidn del pensamiento irradiante y por lo tanto, una funcién natural de la mente humana.”

‘Una poderosa técnica grafica que aprovecha toda la gama de capacidades corticales y pone en marcha el
autentico potencial del cerebro.”

“Es una método que destila la esencia de aquello que conocemos y lo organiza en forma visual.”

Definicién.

Es un diagrama no lineal o estructura grafica radial, en el que se plasman, en un solo plane, fas principales
ideas vinculadas a un tema central, sefialando explicitamente cémo se relacionan entre ellas por medio de
palabras clave, imagenes, lineas, formas y colores. EI modelo con gue se trabaja replica la forma en que el
cerebro procesa la informacién a través del pensamiento irradiante.

" El pensamiento irradiante. www.gdsig.com.ar/mindietMapas%20Mentales%202-130.him - 3k -
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. 1.1.2. Beneficios

o Aprender en forma sencillay
divertida

o Recordar con facilidad

o Estructurar [a mente

a Crear nuevas conexiones
neuronales

o Desarrollar la inteligencia.

o Aprender en forma sencilla y divertida: lo que incrementa la confianza en las propias
habilidades que de manera inmediata se refieja en los resultados que se obtienen (mejores calificaciones)
mejora la concentracion, ya que cada etapa de la diagramacion mental es sumamente rapida y
corresponde en su totalidad a los ritmos de eficiencia del cerebro, permite que uno se enfoque en la tarea
sin dispersarse.

o Recordar con facilidad: Cuando se trabaja la informacion a través de los mapas mentales, aun la
mas extensa, compleja y abstracta puede ser retenida en la memoria a largo plazo con una eficiencia
cercana al 100% y con un esfuerzo minimo.

o Organizar el pensamiento: Dado que en la metodologia de su elaboracién se involucran procesos
de la mente en forma sencilla y organizada, permite estructurar, secuenciar y relacionar las ideas vinculadas
con el tema, distinguiendo las ideas centrales de las secundarias.

Stephanie Wilson, creadora de la auto-organizacion sefiala que: “Todos los conceptos de orden, desde el

.mas simple hasta la mas compleja tecnologia de un cohete espacial, comparten este principio.” La idea
que subyace es. “Cualquier sistema intelectual o practico siempre tiene un polo central, alrededor del cual
se agrupan los demas componentes.™

o Establecer de nuevas conexiones neuronales: A través del pensamiento irradiante, principio
clave de los mapas mentales, se establecen asociaciones de: pensamientos, sentimientos, imagenes,
recuerdos, impresiones, nuevas idas, etc, en forma libre y en progresién ilimitada, {que nosotros podemos
parar, de acuerdo a nuestra finalidad), ya que cada uno de los elementos anteriores, genera sus propias
ideas, pensamientos, codigos, etc. Esto permite explorar todas las posibilidades creativas de un tema,
desarrollar fa imaginacién, ver las posibilidades existentes para tomar rapidamente decisiones correctas.

* CERVANTES (1999: 28)
INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO -5-
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La irradiacion es un patron que se repite en la
naturaleza y se presenta en la forma en que la neurona
procesa la informacion,

Por ejemplo, si deseamos encontrar |as diferentes
formas de resolver un determinado problema, nuestra,
mente genera una serie de ideas que nos permiten
contar con una serie de alternativas para este fin.

a Desarrollar la inteligencia

En habilidades de:

= Percepcidn . [maginacion
= Analisis = Ldgica

»  Sintesis »  Deduccién
= Retencion » |ntegracion
= Comparacion = Creatividad

1.1.3. ; Donde se usan actualmente los mapas mentales?

Los mapas mentales han alcanzado una gran difusion en todo el mundo que ha expandido su uso més alla
del ambitc de la ensefianza y el aprendizaje. Se han empleado tanto en universidades, como en
organizaciones industriales y de servicios, especialmente en los departamentos de planeacion, capacitacién,
creatividad y nuevos disefos. También se han puesto en préactica en el hogar.

1.1.4. ; Qué personas pueden obtener beneficios del empleo de esta técnica?

Personas de todas las edades. Los nifios y jovenes pueden usarlos para aprender a estudiar, resumir libros,
tomar apuntes y desarroliar sus habilidades de pensamiento. Los aduitos los emplean para optimizar sus
recursos, tiempo, dinero y esfuerzo. Los miembros de un grupo, ya sea laboral, familiar o social recurren a
ellos para planear y organizar sus actividades, aprender y resolver problemas en equipo. Las personas de
edad avanzada que han perdido la confianza en sus capacidades, pueden adquiriria nuevamente al poner en
practica esta técnica.

INSTRUCTORA: L1C. NELVA E. EHRLICH QUINTERO -6-
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1.1.5. Aplicaciones mas frecuentes

En la toma de apuntes y

elaboracion de
resumenes

En juntas de trabajo y
presentaciones

En la toma de decisiones

En la planeacién, etc.

De un libro

De una conferencia
De un curso

De una sesién

Planear el orden del dia .

Registrar graficamente las aportaciones individuales de los asistentes
Las conclusiones

Los compromisos

Conocer todos los factores que estan en juego para valorar:

Las ventajas

Posibles dificultades y riesgos

Problemas

Las posibles formas y estrategias para conseguir fos recursos, etc.

En el establecimiento de objetivo y metas

En la identificacion y evaluacion de factores actuales y futuros con efecto
en el objetivo

En el desarrolle de un enfoque sistematico para el logro del objetivo.

PROCESO DE
PENSAMIENTO

» ELDO UN OBJETIVO
OTEMA

» GENERQ IDEAS (2
hemisferios cerebrales)

& ORGANIZO (ideas
primarias y secundarias)

b USO CREATIVIDAD
b SINTETIZO

APUNTES
RESUMENES
JUNTAS TRABAIQ
PRESENTACIONES
TOMA DECISIONES
PLANEACION

EL APRENDIZAJE ES
SENCILLO Y DIVERTIDO

RECUERDO CON
FACILIDAD

ORGANIZO MI PENSAMIENTO

CREO NUEVAS CONEXIONES
NEURONALES

DESARROLLO INTELIGENCIA

MAPAS PERCEPCION IMAGINACION
MENTALES ANALISIS LOGICA
" SINTESIS DEDUCCION
EDUCACION - -
RETENCION INTEGRACION
HOGAR f o -
W | COMPARACION | CREATIVIDAD
INDUSTRIAS %
SERVICIOS 8
PLANEACION § v

CAPACITACION
DISENO

INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO



UNAM CURSOS INSTITUCIONALES DECFI
“MIND MANAGER”

2.2. Principios, caracteristicas y recursos de los mapas
mentales

2.2.1. Principios en que se fundamentan los mapas mentales’

Principios bas , pensamiento irradiante.
Dilts (1996) y Ontoria (2005) sefiafan los principios ~ © Pensar en palabras y en

basicos que permiten comprender el significado de los imagenes.
mapas mentales. o Jerarquizaciony
categorizacion.

a Pensamiento irradiante

El mapa mental es una herramienta del pensamiento y el aprendizaje muy util, porque sigue el patrén
radial que establecen las conexiones de las neuronas entre si. Un mapa mental irradia siempre de una
imagen central. Cada imagen, cada palabra, puede llegar a ser en si misma, un subcentro de asociacion.
Sirve para esquematizar una red de ideas centradas en un motivo de atencion (objetivo) que facilita la
asociacion de las mismas y su comprension. {Buzan: 1996).

o Pensar en palabras y en imagenes

El surgimiento del lenguaje articulado, por medio de la palabra, permitié al ser humano dar un salto en la
evolucidn de su inteligencia, como lo sefiala Calvin:™

“Es obvio que la capacidad abstracta de la inteligencia estd también interrelacionada con el lenguaje,
porque dificiimente una especie no hablante pueda concebir una entidad abstracta como el tiempo o la
justicia si no esta capacitada para definirla mediante la palabra. Expectlativas acerca de lo que sucederd
después, prevision de posibles problemas, evaluacion de conceptos y comparaciones, definicion de
entidades abstractas, conceptos que se anidan en otros concepios y, por sobre todo, la estrella indiscutida
de la evolucion sobre el planeta: el lenguaje. *

Durante mucho tiempo, en el mundo occidental se enfatizo la importancia de la palabra como vehiculo del
pensamiento, como instrumento de comunicacion e informacion. Sin embargo, a partir de los descubrimientos
de Sperry, efectuados en la década de los 60's del siglo pasado, acerca de las diferentes funciones que
desempenan los dos hemisferios cerebrales, se conoce que la imagen estimula gran variedad de habilidades
de!l cerebro, como los colores, |as lineas, las dimensiones, etc.

A través de los mapas mentales se trata de establecer un equilibrio entre el uso de la palabra y la imagen
para incrementar fa eficacia del cerebro.

o Jerarquizacion y categorizacion

;*ONTORIA, A. et al: Potenciar la capacidad de aprender y pensar. Narcea, S.A. de Ediciones Madrid, 2005, {119 - 122)
CALVIN, en: DOS SANTOS, M: La evolucion de la inteligencia. (2006) www.mcds.com.ar

INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO -8-
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El mapa mental, al igual que ofras técnicas, facilita la ordenacion y la estructuracidon del pensamiento en
forma radial.

Esto se logra a través de la identificacion de las “Ideas ordenadoras basicas” relacionadas con un tema ¢ idea
central. Estas representan las ideas clave, a través de las cuales se organizan los conceptos vinculados con
cada una de ellas, en funcién de su importancia. Son las categorias de primer orden, que incluyen
subcategorias, de segundo orden y a su vez crean nuevas asociaciones, hasta que se consideren suficientes
para preparar un trabajo: (como una reunion, un curso) o para resumir (el contenido de un libro, de una
conferencia, efc).

Estos principios permiten elaborar la estructura basica de un mapa mental, para lo cual se siguen los
siguientes pasos:

1. El asunto o tema motivo de atencién se
presenta en una imagen central.

2. Las ideas basicas generadoras, los
temas principales irradian de la imagen
central, en forma ramificada. (ramas de
primer orden, cada una asociada a sus
respectivas ramas de segundo, tercer
orden, efc).

3. En cada rama se coloca la respectiva )
idea, a través de una palabra clave o TN T 5
frase corta y/o una imagen. - N B

4, Las ramas forman una estructura nodal
conectada.

Para seleccionar y procesar la informacion abundante disponible actualmente sobre cualquier tema y poder
transformarla en conocimiento, los mapas mentales constituyen una gran ayuda. Esta técnica, asi como otras
de diagramacion mental (como los mapas conceptuales, los diagramas de bloques, etc), son sumamente
uties para utilizar el potencial del cerebro, ya que ademas de estimular el aprendizaje, ayudan a desarrollar
las habilidades mentales.

Ontoria (2005: 121) refiere una cita de Mc Carthy a este respecto: “El conocimiento es el resultado de
personalizar la informacién, de convertir la masa de datos entrante en conceptos e imagenes significativos.
Este proceso se desarrolla reflexionando sobre la informacion que nos llega, comprendiéndola, evaluandola y
traduciéndola al lenguaje que nosotros utilizamoes.”

INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO -9-
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2.2.2. Principales caracteristicas de los mapas mentales

Participacion consciente
Aprendizaje multicanal
Organizacion
Asociacion

Palabras clave
Imagenes visuales

Mc Carthy * sefiala los siguientes factores o
caracteristicas de indole técnica como
personal, involucrados con la construccion de
los mapas mentales.

C OO0 O0OD0OOD

Participacion consciente: La elaboracion de un mapa mental permite tomar decisiones sobre cual es la informacion
relevante que se va a incluir, como reducirla a frases clave, como organizarla, etc.

Aprendizaje mutticanal: En 1a codificacion de la informacion es multisensorial o sinestésica. Por ello se emplea todo
tipo de formas, dibujos, colores, palabras, nimeros, representacion de sonido, efc.

organizacion: Esta vinculado estrechamente con el principio de jerarquizacion y categorizacion, arriba sefialado.
Cabe agregar que, con el propésito de optimizar los beneficios del mapa mental, se requiere ei desamollo de
la comprension del significado del tema a abordar, la distincidn de las ideas centrales y las secundarias, asi
como su integracion en una representacion grafica en la que se vea claramente la estructura, la secuencia y
la relacion de las diferentes ideas.

Asociacion: S€ busca asociar y agrupar las ideas, de forma no lineal, empleando diferentes formas, colores y
simbolos para relacionarlas. Estas ideas pueden surgir de pensamientos, experiencias, impresiones,
imagenes, efc.

Patabras clave: S€ buscan principalmente nombres y verbos que sean significativos y eficaces para la evocacion
de lo aprendido.

Imagenes visuates: Dado que predomina el aprendizaje de tipo visual, su representacién grafica y atractiva,
acordes al gusto y costumbres de las personas, estimula su retencion.

Los mapas mentales constituyen una gran ayuda para seleccionar y procesar la informacién abundante
disponible actualmente sobre cualquier tema y poder transformarla en conocimiento. Esta técnica, asi como
otras de diagramacidn mental {como los mapas conceptuales, los diagramas de bloques, etc), son
sumamente (tiles para ulilizar el potencial del cerebro, ya que ademas de estimular el aprendizaje, ayudan a
desarrollar las habilidades mentales.

Ontoria {2005: 121} refiere una cita de Mc Carthy a este respecto: “El conocimiento es el resultado de
personalizar [a informacién, de convertir la masa de datos entrante en conceptos e imagenes significativos.
Este proceso se desarrolta reflexionando sobre la informacion que nos llega, comprendiéndola, evaluandola y
traduciéndola al lenguaje que nosotros utilizamos.”

INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO -10-
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2.2.3. Recursos

Las leyes de la diagramacion de un mapa mental’
Su finalidad es: faciifar el desarrollo de un estilo personal de diagramacion

1. Iniciar siempre un trazo de un mapa mental con una imagen central que
involucre por lo menos tres colores.

2. Conectar tantas ramificaciones a esta imagen central como se necesario. Afiadir grosor a las ramas
principales a fin de enfatizarlas. También se puede utilizar este recurso cuando se requiera resaltar la
importancia de una idea o dato.

3. Elegir solamente palabras y/o imagenes clave. Procurar que la extension de las palabras no exceda la
longitud de su rama correspondiente y emplear solo letra de imprenta.

4. Utilizar imagenes a traves de todo el mapa mental.

5. Agregar simbolos, flechas y colores con la finalidad de establecer vinculos o asociaciones entre los
diferentes elementes.

6. Emplear recursos dimensionales. Contornos que permitan enmarcar la totalidad de los elementos que
integran cada una de las ramas principales, a fin de establecer una secuencia entre ellas u orden
numerico.

2.2.4. Condiciones optimas para las sesiones de trabajo
Entre ellas se encuentran las siguientes:

Confianza en la propia capacidad: Recordar que nuestro cerebro tiene mulfiples habilidades que
podemos emplear.

Sentido del humor: Nos permite disfrutar de esta experiencia y activar los recursos creativos de nuestra
mente.

Reunir las condiciones mds favorables en nuestro espacio de trabajo o estudio:
Ventilacion, iluminaciéon y temperatura adecuadas, amueblado agradable, un silencio que favorezca la
concentracion y una musica que favorezca la sintonia entre la mente y el cuerpo y favorezca nuestro
aprendizaje y creatividad.

* CERVANTES: (1998 38)
INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO -11 -
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2.2.5. Ejemplos de aplicaciones de los mapas mentales

Antes de iniciar la segunda parte de este {aller, Mapas Mentales Digitales en Mind Manager, se presentan los
siguientes ejemplos para que ustedes elijan los que primero desean hacer a través de lapiz y papel y después
utilizarlos para disefarlos en la version digital. Se sefialan aquellos que previamente hemos preparadc
tambien en version digital.

Se incluyen los siguientes temas, acompanados de formatos para que ustedes los realicen, con base en sus
prapias ideas y necesidades.

Tema 1: Definicion de objetivos en aspectos clave de la vida.

1.1. Mis objetivos clave (incluye ejemplos de algunas areas comunes en nuestra vida).
1.2. Objetivos laborales.

1.3. Objetivos de desarrollo personal.

1.4. Objetivos de familia.

1.5. Objetivos de diversion. {Version digital).

Tema 2: Plan sistémico para lograr un objetivo.
Tema 3: Administracion del tiempo.

Tema 4: Disefio de proyectos.

Tema 5: Revision de proyectos.

Tema 6: Preparacion de una reunién. {Versién digital).

Tema 7: Disefio de proyectos. {Version digital).

INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO -12-
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DEFINICION DE OBJETIVOS EN ASPECTOS CLAVE DE LA VIDA

&, DIVERSION

MIS _\
OBJETIVOS |
CLAVE &/

'

22> DESARROLLO FAMILIA

’
%
YW
%,
%
o e 5p0

]
1 PR FTS
OBJETIVOS
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OBJETIVOS |
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PLAN SISTEMICO PARA LOGRAR UN OBJETIVO

Estrategia de pensamiento para decidir la accién a través de un plan sistémico. (Gonzalez, L.
J.: 1998)

A través de diferentes investigaciones se ha descubierto que uno de los procesos
de pensamiento mas efectivos que seguimos para lograr éxito en lo que nos
proponemos (y que ademads fortalece la motivacién), esta integrado por cuatro
pasos fundamentales que aparecen en el primer cuadro de la pagina siguiente,

Instrucciones: Utilice la informacion que aparece en el mapa mental como guia.
Ponga en prdactica esta estrategia de que menos una vez al dia durante tres
semanas para que su mente adquiera el habito de aplicarlo a diferentes asuntos.
Conviene que lo practique tanto en forma escrita como verbal, ya que le
permitird asimilarlo con mayor efectividad.

4. FLEXIBILIDAD 1| %04 1. OBJETIVO
o - o
8
73] -
3 s
o 1
SISTEMICO =
LOGRO 7CUAL ELWO? (Subrdyalo con un color)
OBJETIV O
fﬁﬁ, 3. SENSIBILIDAD [ ¥ -@ b
% g 2. ACCIONES fﬂ;;
(INDICADORES)
Cualitativos Cuantitativos @
=z
8
3
z
¢Cudles elljo? (Subrayalas con un color)
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ADMINISTRACION DEL TIEMPO

Planear

Crganizar

+ Trahajo

Proyecto MM

$ Boletos :ﬂ.;:

Familia Cumpleafios JJ
Desarrollo  Diplomado Liderazgo
Diversién Excursion familiar

Diversion

$ Pago renta
Junta familiar m

@ Maestro de Juan

§

Planear vacaciones %

R X

=i

DISENO DE PROYECTOS
}

?2POR ?7QUE?

QUE?
i P2QUIEN?;

?DONDE? "
'PROYECTO
2COMO? ?CUANDO?

INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO

-17 -



UNAM CURSOS INSTITUCIONALES DECF!
“MIND MANAGER”

REVISION DE PROYECTOS

Areas clave de mejora Fortalezas internas

g

==
Obstaculos del entorno .

o/
!&!, Debilidades internas
)

Oportunidades del entorno l

Opo

PREPARACION DE UNA REUNION

1
Minuta Sesion Objetivos i'z
00000

Fecha

L~ Inicio:  Fin:

2 > I Logistica

Documentos soporte SEERY Lugar:
s~ )
- T
: G
B i B
p <
REUNION
Acciones - Decisiones @
k=]
W o
o E
o —c
] [4b]
: =
[w] i)
a (1
D
o
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Este mapa trae productividad real a las reuniones de trabajo: Reuniones que toman menos tiempo, que llegan
a conclusiones claras y construyen un ambiente de alto rendimiento y productividad. Antes de la reunién,
permite planificarla facil y rapidamente y enviar a los participantes la informacién de la misma para su
preparacidn. Durante la reunién, le da a los participantes concentracion, organiza y dirige la conversacion,
mientras invita a un ambiente altamente participativo. En su versién de Mind Manager, se pueden ir anexando
las aportaciones de los participantes en tiempo real y se toman decisiones en la medida de lo requerido.
Después de |a reunion, permite distribuir entre los interesados [a informacién de las decisiones o acciones a
realizarse: en mapa, Word, Power Point, Gantt y Proyect. *

TOMA DE DECISIONES
|
' Asunto:
2 PROS
’ 1
! A O Objetives |2
N Iﬂ_ OPCION 3 deseados [
3 ] :
? 1
- A |O Criterios |2
iy seleccion [ 3
seleccion
I
: 2
PROS
: ) CONS 2
; R ) e E—
Valor
valor Criterios
Criterios celeccion

seleccion

Decisiones Efectivas

Este mapa guia y facilita el analisis y comprension de atternativas para la toma de decisiones. Establece una
clara comparacion entre distintas alternativas en relacién a los objetivos deseados.”

* Flexus Group. Mapas Mentales Digitales. Version Demo. 2006.
* Flexus Group. Mapas Mentales Digitales. Version Demo. 2008.
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1.2.6. Lecturas sugeridas

£ BUZAN, T. & BUZAN, B: : El libro de los mapas mentales. Como utilizar al maximo las capacidades de la
mente. Ediciones Urano, México, 1996.

£l CERVANTES, V. L: El ABC de los mapas mentales. Asociacion de Educadores Iberoamericanos,
México, 1999.

L1} CERVANTES, V. L: El ABC de los mapas mentales para emprendedores. Asociacion de Educadores
Iberoamericanos, México, 2001.

L1 CERVANTES, V. L: El ABC de los mapas mentales para emprendedores. Asociacién de Educadores
Iberoamericanos, México, 2001,

LI} CERVANTES, V. L: La percepcion para ¢l cambio. Ascciacion de Educadores Iberoamericanos, México,
2001.

L0 IBARRA, L. M: Gimnasia cerebral, Ediciones Gamnik, México, D. F., 2000.

L) IBARRA, L. M.: Mapeando con Luz Ma. Ediciones Garnik, México, D. F., 2001.

L) IBARRA, L. M.: Aprende faciimente con tus imagenes, sonidos y sensaciones. Ediciones Garnik, México,
D.F., 2002.

(1) GELB, M: Inteligencia Genial. 7 principios clave para desarrollar la inteligencia, inspirados en la vida y
obra de Leonardo da Vinci, Quebecor Impreandes, Colombia, 1999. Cap. Arte / Scienza

I SAMBRANO, J. & STEINER, A: Mapas mentales. Agenda para el éxito. Editorial Alfaomega, México,
2000.

EQ SORDO, R. M: Una aventura divertida con mapas mentales. Garnik Editores, México, 2000.

El ambiente de trabajo de Mindjet MindManager

MindManager es la mejor y facil manera de hacer mapas mentales, ofrece una interface visual altamente
intuitiva entre equipos de trabajo y en forma indivuidal para capturar, organizar y compartir ideas. Permitiendo
la administracion de tareas, ideas y proporcionando un panorama general para llevar a cabo las acciones
pertinentes y asi lograr los objetivos planteados. Con las utilidades de exportacion a otros programas como
Microsoft Office se puede lograr presionando un solo botén, lo cual nos ayuda en ia generacién de reportes,
presentaciones, paginas Web, sistemas CRM y mas. Inclusive existe una version para pocket-pc. Existen dos
versiones del programa: Basic y Pro
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Reconociendo [a pantalla
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La barra de herramientas

E’.;?e”' ‘ - {_A {f’i x E;J Al__j@cu iESendasE-mai @Pa:kmdeo Ejhnt ﬁswmﬁes wa x;,.gl.x_gi«; E ¢
‘??-*23@“-'-1‘§*ﬁ W.@&)@ QQiw FHEM.ID L X @@' 5 s

AT N ST S S ———

E SR A S R S T

A continuacién se describiran los principales iconos de la barra de herramientas:

HERRAMIENTA DESCRIPCION
ABRE UN MAPA EN BLANCO
CON TOPICO CENTRAL

AGREGA SUBTOPICOS

INSERTA RERLACIONES

INSERTA LLAMADAS

AGRUPA TOPICOS Y
SUBTOPICOS

PERMITE CAMBIAR EL
FORMATO DE UN TOPICO

INSERTA MARCADORES

i SALVA EL ARCHIVO DE
> TRABAJO

;f = | INSERTA NOTAS EN LOS

= TOPICOS

: @ ; ~ ADICIONA ARCHIVOS AL

R MAPA

o Gof?g CONVIERTE EL MAPA EN
: | ARCHIVO .ZIP

ot 7 ot

INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO . -22-



UNAM CURSOS INSTITUCIONALES DECFI
“MIND MANAGER”

Abriendo un mapa

El primer paso para crear un mapa comienza abriendo el mend File.
entonces hacer clic en Default Map o presionando en €l icono de la barra de herramientas

Eile f Edit View Insert Topic Format JTools Window Help ™ - . |

l? _New : bl ,‘fj Default Map

175 open Ml ¢ e
lﬁ P ‘ - ..; From Styles and Templates..,  Ctri+N
; ¢ Import R 2 B

4 4 port - » -, From Existing Map. ..

Existen dos altenativas mas para crear un mapa mental;

1.- Abrir un mapa desde New> From Styles and Templates apareciendo la siguiente pantalla

5 Style Templates | Map Templates | ST e o I
4 Choose map:
. o ;
i LA o iy »
W’*“ré;i”ﬁ;"ana ; N !
S, aj.m%;:
I et "
bt i T -
o gy
PR K
Al R .
fme T
e I
B Ym e
To-do kst

\ e DN

it e |

Visio Parallel Flow Yisio Go To Loops New Blank Map Tablet (X5)

R AR et

[ Aceptar 1_1[ Cancelar ]

A continuacidn seleccionamos el mapa que utilizaremos.

2. Seleccionamos un mapa de la galeria de mapas que se encuentra en el costado inferior derecho de la
pantalla seleccionamos la pestafia Learning center
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 Learning Center.
;»mvv‘uw«wwmm e

, Getting Started
i

iveuncos e

Ly

H
3
e T astow b e sl e e e e ¥
5
t
P
i
i

; 3 Explore the Benefits of Mapping
{&1 Tutorial for New Users )
'l

;

i

[l &2 Add isual Cues

i' (& Change Map Format

L ety

{9 Add Extended Information
(&3 Maps and Microsoft Office
More Tukorials Orline. ..
Get Onlne Traming. ..

g

saanjiely dey

T r e e

Learn More

!
!
¢
¢
¢

@ Keyboard Shorteuts
@ Tips and Tricks
More Tips and Tricks Online. ..

T g

i
H
i
5
¥
t
€

i 1 ) 3 .

: @J Yhat’s New in MindManager & B

g Map Gallery &
b — ) &
: Sample Decision Makin =
Bl e ’ :
' &8) Sample Meeting i
@ Sample Org-chart g i
o8] Sample Status Report <
Y
: @ Sample To-do List i
f ; Onlne Map Gallery. .. §: :
: Ak
: =z
:@;} ;
A -5
il B
I 2
1. 5 !
. a8
> £
- U T
_g », §
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5 oten ‘?J - .‘Eﬂ [gg x ,f,__:b X L] & s.br.r][;.}{_]SendasEmaﬂ &Packand'so @nunm@feamrm “

%
?
{gxl Eie Edlt \few 1nsert Topng Foimat ook Wmdow Help L o T,p"axf".‘-("éru rhep [-. EX
¥
1]

B D& ! a.!tz'l 9 ae@is; 8 i‘ft "B

|

i
[ o

i
w o

lEnter spard h ex i"_} ﬁ&l -

Cada mapa nuevo empieza con un tema central o titulo. Para empezar, haga clic en el tema central e
introduzca el nombre del tema central. Entonces, continde para agregar temas principales y subtemas,
presionando la tecla enter.

Creando Tépicos

Con el mapa en blanco podemos agregar los topicos necesarios asi como modificar el formato de los mismos

de la siguiente manera: | 1 o To6 Vi 165
& b
Tmrirtmme ey Soaniediry
@ Stbhnt . : Insert :
@m ZreSerscaastinsan
(“‘ \Ju.! Tza Crellpe st Brhy
& FoangTope
::'_:‘ Faniey g dieth
ot o lzygadssd]
s )i—? " .
Mirossht ExcelRange...
Moot Qubken - '
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Topico principal insertado
en el topico central de un
mapa en blanco

; onic = Subtopic - _
e Topie J&: T e

e T L Subtépicos insertados en
L el topico central asi como
o ~ topicos flotantes

__Central Topic

1% o e

v

> L At
R B I S
e e a0 "

Moviendo Topicos

Usted puede mover un topico haciendo clic en él y arrastrandolo a una nueva posicién. El tema y color del
eslabon cambia a rojo, y usted suelta el raton que movera a la nueva posicion

5

R M .

| r[,z—!:gatiné To;;;;mﬂ

; ) Subtopic AT -:'1:- %53‘3“*3
e Main Topic | ik S e

.;[_?.¢éﬁtr_a! Topic

Mom

e

\\s{ Main Topic |
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Convirtiendo un subtépico a toépico flotante

Cuando se quiera convertir un Subtépico ligado a un tema central como tépico flotante se selecciona el
comando Edit y presionar la orden Convert To Floating Topic. Para revertir la accion presionar control + z, 0
simplemente seleccionar el tépico flotante y acercarlo al topico que estaba unido inmediatamente surgira una
linea que unira los topicos.

Relaciones

Usted puede agregar lineas para representar relaciones entre los temas para los cuales hay una conexion
entre los dos Temas. Seleccione el menu

Insert> Relationship

et | Topl  Format - Jooks'- dgrdow . ok«
ﬁ (£33 trdry -
boxxe { '-s_)!r'm},’:'fﬁi!,: irsrdas fidek ' Subtomcc ...... - B
& subtope Insert #, Main Tupic |r- Sultapic .
= ubwo-c S
Sarerd Tapic " Gt g s - R
@ dtux o deish U
£ pndey o HuyusdastB e g e
[ Relbonshg® T F LGP ' o [ " ouotope®
| Hapat. Sl tmenase .7 o Main Topie [-"@ S T
; . . L | Subkopee ¢ . L L1
;hamdtﬂxcdkmge...
Mcosoft Quilook ttem - »
C. t . ‘
T
P M e
B "o:uw
T Relacion mostrando las
L extremidades para modificar
S la forma
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Llamadas
Usted puede agregar una llamada a una relacion o un topico. Sirve para proporcionar informacion mas

detallada acerca del t6pico 0 para resaltar la naturaleza de la de |a relacién, puede

. {Subtopici/
-l Main Toapic e Sublopitf‘ '
CBublopic "t ¢

'untra! Toplc )
o 38 ;h L]

. Subtope®”

B e | = i "
{Main Tapic Jof Suotere.

Agrupacion

Usted puede agrupar un tema y subtopicos insertando una linea que los limite. Primero haga clic en un tema,
0 temas para seleccionar el icono de’ Boundary'. Esto abrird un mend que mostrara varias opciones para el
seleccionar el tipo de forma de agrupacion. Seleccione uno y hace clic para aplicar. Si usted selecciona un
tema con el subtopics, el limite tambien rodeara el subtépico.

£

Sl G HE s

Curved Lines

Straight Lines _ .
Zigzag ‘ ‘ . ' __'_M__,_.,,._m \
@ Scallops ' i . ‘ &*w | Subtapicqf .
,' Rounded &;aétangle | &

Rectangle

-é]- Summary - Elbow

-E} . Summary - Sheared Elbow
-6} Summary - Arc

-&) Summary - Curve

A ‘ Delete Boundary
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Para cambiar la manera que la linga se despliega seleccionar Format del mend principal, elegir el tipo de
agrupacion, esto abre la ventana. De agui usted puede ajustar la linea el color, grosor y modelo. Para
estructurar una agrupacion usted debe seleccionar un limite primero, o este quedara fuera.

%-Toals., - "'.-;'.t‘_indnw

Help s

Togh: Fort, .

Topic...

T,

I;?sf‘lﬁ - B_DUI'IEIEII"?“. ' ﬁ%'"c.wgs\ » i;- . ;

.7 | Relationship...

e w7

2 E e - eeesnmnnr e« ons aereraenene

G Straight Lines

I @ Curved Lines

5 Scallops
L.,J Waves
E‘E] Zigzag
=) Rounded Rectandle
Rectvan'gle ‘
'E]- éummary: Elbow
2 -E} Summar;y:- Sheared Elbow
’ f}, Summary - Arc

-E) Summary - Curve*

e ‘«w RSP

‘:_Ggl)or:

ﬂfﬂghtl I ;l'-l pt . ——} [\?il
lf_iﬂ_—\— - ==

iﬁidr: Hj Automahc >

] [ Apply, ]

INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO

-20 -



UNAM CURSQS INSTITUCIONALES DECFI
“MIND MANAGER"

Numeracion

Usted puede numerar automaticamente ios temas del mapa. Podria usar esto, por ejemplo, si usted esta
planeando la estructura de un informe. Para preparar numerando, del men( del Format seleccione
Numering.

Esto abre la ventana de la enumeracién. Aqui usted puede def inir el esquema de la enumeracion y el los

hiveles a ser numerado,

f?gr?ﬁét% Tools WII‘IdUW Help

"A  Topic Font... . :
AR

! Tc:pn:
" Bou %ﬁdﬂi‘v Numbenngst eme: E.l.l.ii
! ) Relationship... ‘ . Depth: . ‘ |1Leve| @1

ENO number repeat

=, Numbering,...,

i1

: Change Case..
T%l Sort Topics...
§ Microsoft PowerF‘nlnt Slldes. "
MP¥ Preferences...
1
i
: Style »
i Map Marker >
; Backoround... L
. Notes... ey ) i

f%'.‘gernc«;en}z;riamq 31 oK ” -Cancel

1"2 'Sumdbi&- 1.2.1. Subtopic

‘:‘ 4 Sublupac
1235, Sublopic.. -

ey

1‘3 Sub!oplc ’ a

,M Sbﬁlogio X
[ Shtepic:

Suﬁﬁlé;":_‘:l(_:;
“Subtopit

%2.375ubtdpie..: 2i3:17 Subtopic. | - -,
A -

ks A

2 4bSublopici.: 241 Subtopict, .,

i srsmisamims el
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Formateo
Usted también puede cambiar la apariencia de sus topicos o temas a partir del mend del Format >Topic.
Para cambiar la apariencia de un topico usted debe seleccionarlo primero, o esta opcién no surtira efecto.

g Shape and Color }_Altgnmcnt § Size and Margins " Subtoplcs Layout EW General Layout%

Shape for tomc . s Line -

ID Automatic | Color: - [! Automabic L\;l

e No Lene

- Line

1_4_““ } Rectangle FEH] o, e o e o i e
{ %} Rounded rectangle Color:
<E5> Hexagon A - -
@ Ockagon Transpare_ncy:

~;o @ Circle ; T

Y Oval

AL Custom image

s
BN ;
B I e N Y e T

Usted también puede cambiar la apariencia de sus topicos usando algunos botones dela barra de
herramientas que se encuentra en la parte inferior de la pantalla
=3

L2 CER Rle £ f- B A8 B A

Lepo) Sublope )
topic -} - e,

Main Topic & Subtopic

Subtoplc

(
|
Lom
\y

Esta figura nos muestra las opciones que MIND MANAGER puede lograr.
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Text Marker (Marcado de textos)

Pueden agregarse los Marcadores de texto para dar informacion adicional a un tema, para el ejemplo si
usted estuviera planeando una serie de talleres o conferencias y quiere agregar los detalles del ponente. Los
marcadores del texto le permiten agregarlos.

El grupo y un Nombre para el marcador. Usted también podria usar esto para diferenciar los grupos en una
clase. :

Seleccione el tema al que usted quiere agregar un marcador de texto y pulsar el boton el Texto de * Text
Marker . Agregue un Grupo y Nombre para el marcador y clic OK

R
/e» Sess:on 11—
: |Pras«enter s Beasley]

R Rl Rep ek

o

,r:j Session 2 E—O"r

2 f L]Pmsamar* S Paacock f

Session 3 -

Presentar: J Smith |

Agregando notas al mapa

Las notas aparecen como pequefios iconos en el mapa. Usted puede usar notas para adicionar informacion
extra que puede ser complicada en los mapas.

Topic [: Format “Tools wWindow ~ Help
!‘ﬁ?}»: Icon Marker o N
' Text Marker ’
EE TR
i ~ Image 4
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Mair Topic J|BM-- -{? Bulpars, ., Y
i
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£

LEN i"‘f”!z

.

“s . et r—-——-—--»«--»ﬂ o B ST
Q‘,u‘d - El-—*--”--piu, e -~

Usted puede también agregar imagenes y direcciones de internet a las notas.
Para leerias basta con acercar el puntero de raton y se desplegara el mensaje que esta escrito.

B __:gabi‘;sﬁi‘c“‘r';};;_ |

ISubtopic ™

Heré [can add notes el atopic.

Dvyzidwhal

Agregar de marcadores de mapas

Usted puede agregar marcadores de mapa para ayudar con la planificacion del proyecto. Puede resaltar las
prioridades a cada tema, o marcar qué porcentaje del avance de la tarea que esta realizando. Estos pueden
ser utiles cuando usted revise el avance del proyecto.

INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO -33-



UNAM CURSOQS INSTITUCIONALES DECFI
“MIND MANAGER”

;.ﬁm {el Mindtiannget Proc fExemplaapty],
§¢§J~ £k B Jnsed o Topag sm..,‘w,m.,m

"_‘i Fa’%ﬂimieé{ L,.J Qf»»A, 5

L Thactresitndtn
(R w R FETEEY IS SR PEE T
Teeil eIt

| ' H .
e st e R [ o et i L g b G
P v ~ e N W Lo [SETE ' S Smnomet

573 ST el Pt - o e o
i A4 Fosrey

o swbtopic o E
{ Submp_lc_

! ‘1‘_ . . q,z ) Proets s
T e Mam Topuc j( .{Sub!op 'c"";g:SUbtoglc
Y EE / ] ; Subtopic L

B Paakr 5

Tavk Covopsnte £}

[} 7ad.stant

[ B Guartin in

[} BB

O Trvou cpinian o

] Ta o)
~ - Hesmio s

Sl g &

& 0 Swgde Sooms "j‘
P Goles ry
T AT WP 4

\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\\

v
e e
oL BRI LR B LI

5 ; o N Ny g
?45; 4 \ tuui:mnm] e o

M.W“ -‘«“AG H @ £ m.ég é

4 b A S M e, AL S S

Topic anrmat Tuojs Wlndaw Help<" . L e
|"‘}i Icon Marker .

Task Priosities

DRIDP

v

E:iz Text Marker 3
! oo |rask Eamplete (%)
B Notes Crl+T E‘_} [3 g "] .
" Image ) 4 Smlleys T
- G (a0 cwdy faY
!f:?( Label... . Ctrl+Mayusculas+FS @ '\‘:’ & @ W
Ej Bookmark Ctri+Mayusculas+X Arrows
: fﬂ " Add Attaghment... }}_,f? Vw? @y Vo
: Flags
@: Hyperlnk. .. CtrlK gm gg ? g’ F ? P
@{ Comments. .. CrH+F11 Single Icons
@ Alert... . _‘f_’_t}: _@Lu g.B_.@m
@ Add Date and Time... More Icons...
@~ Task Information... Qrganize Map Markers
S spreadsheet Rermven 243 Tron Marke
o

Custom Properties...

Usted también puede agregar los marcadores del Mapa abriendo la etiqueta en la pestafia del lado derecho
de lapantalla arrastrar y soltar los marcadores hacia su mapa
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Agregando imagenes a un mapa

T

| Fard o o 0

G o e ) Q Q 1.[9%“;:5

\) Text Marker }

g Notes |
o dmge g T s o Fomlbrey..
$7 Lapel.. CrhapusedestS | . From ..

Se pueden agregar imagenes a los mapas desde el mend Topic> Image con las opciones de Biblioteca o
archivo

T B
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N K S S i?‘ Sab N b ' “eLeCommi0 e %]Ck-Commé emf  *JFrm-Comm Y - 5 :
; s 3 @ Armws\ L the c " % MleeCommllent  SCrComSend  FFmrComml0 i
N ‘t‘ X Siow-comm) e MlCrComobemd  FJFmrConmll !
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i @ CUTfntfl.]llfatlUl.'I - ¥  WebFoden 1islpw CommSenf M} Gh-Commtd.caf - ) i
© Add Image.., . S e S | S
3 AR Flopwrt  {Bw-Com? o { ["‘ o
4 : BT e o S
;f_‘ Fhesof e [Adimages [ omo.” ank." el ol a0 g pon.” prgl b [ Coew ].’
L. — = - :

£ e~ e

i' -
{[ Map Marker Icons - . S

i i, b s s Amris smirni oo,

g‘g’g’“@ Aseaqr EJQW ]

Usted también puede agregar una imagen de la biblioteca de iméagenes. Abra esto por haciendo clic en la
etiqueta de la Biblioteca que se encuentra ubicada en la parte derecha de la pantalla. Esto le permite ver de
antemano todas las imagenes disponibles. Usted puede arrastrar y soltar entonces las imagenes en el mapa
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Ligando archivos

Usted puede unir los archivos pertinentes a los temas en su mapa. Puede hacer esto de dos maneras,
agregando una figa a un tema en el mapa o agregando un hipervinculo.

Click en el topico que se desee adicionar el archivo y click en el icono Add Attachment

Mend Topic> Add attachment
| Topic | Format  Tools  Window Help
S lcon Marker . o
‘;:f;‘ Text Marker B R
(3 add exlstngflle as attachment .
@ Nntes . ’ Ctri+T ;
Irnage. T I . hb
{ﬁ' Label... : th|+'MayuscuIas-i_—E5
Ej Bookmark "Ctrl+Mayusculas+K . Sl g R
l:ﬂ Add Attachment. ., "..‘-; T . Eklnf?rrnat‘nn... -
Lo, Hgperinic.. Crisk et srcmentc o,
B3 comments... bt ‘ - : ;

Parte del mapa mostrando el archivo adjunto
Usted vera el icono del paperclip en su mapa, cuando usted rueda ef ratén encima de esto vera los detalles
del archivo. Para abrir el archivo pulse el botdn el icono del paperclip, esto abre el |a caja del didlogo y hace

clic Abierto.

Usted puede ligar un archivo que ya se haya creado o crear un nuevo documento vacio. Por ejemplo podria
ligarlo a otro mapa que se ha desarrollado. Para adjuntar el archivo clic OK

\
il T

.
3o
P RN
1

NN A

Crestex SBEY BBS
et COGEIE5 o
S BN

- f. .
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{Rw«r velwiw% E_g:nbns ] { (;K : ] I_ Cancelar

R

,Topcfﬁmat Tk Widow e -

ﬁ} Teon Herker v
. Tt M ]
§ ot kT
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;3 . oS
ﬁ Bookmark CritMeyusniass
] Adddtagment.

T

CUADRO DE DIALOGO PARA ESTABLECER HIERLIGAS

. Subtopic . A
ain Topic JE;:.:}-;'Subtopsc -

)

Snuhtnnics

" : Locattcm Http: .f.fwww goagle Eouks
Type: Hyperlink -

Ejemplo de hiperliga
Usted vera el icono en el mapa, cuando cologue €l raton sobre esta liga para ver los detalies de la liga. Para

abrir el archivo clic sobre el icono, esto abre la hiperliga en una ventana de navegador

Tipos de vistas

Diferentes vistas —abriendo y cerrando subtopicos

Cuando se trabaja con un mapa algunas veces puede ser Gtil colapsar los topicos o expandirios para poder
analizar el mapa mas claramente. Antes ¢cada grupo de subtopicos
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2 Main Topi |2 Sublepie [ o ioni

Subtopicos expandidos y subtopicos colapsados

= *Main Topic &
A ‘

e

S
st 1y

=t e ;. .
SRANSEL. s

Usted puede ver el mapa para mostrar los diferentes niveles de detalle, seleccionar el mend View-Detail

View f Insert  Topic Fg_rmaflg

Map

Outline

(&1 (77 |[]

Multimap Workspace

! Presentation

g

-1 Toolbars - 3

Show { Hide »

fFocus Topif F3

l . . Detail - !H Collapse Topic

Masuselas+aR+0

ClrF3
" CtrlFs

"ot Center Map " show Level 1

Fit Map - Thow Level 2

Show All Levels

Mayusculas+alt+1
savtseulas+alt+2

Mavusculas+alt+a

* Pan and Zoom
. ranandzoo Toagle Detail

%8 Balance Map

VP

Chrl4+D
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[El Map View- [

Taap s
=] outline view

% Multimap Warkspace

8 _ Bresentation Mode

i s '
2. ' R ;4% oo Yag
. . wrlh, ¥ E sty
- el T oy e ppd i
§ e won A A o ER L
; - vt e 1 e ‘\? L & -
. - - g " v g K
L A 'ty > : oo ke s
5 M . "B B et
W sy A R 1+ [ §
4 - - ] aby i ¥
1
o o e g - .
\ n % Te s R 2 . I gt
% ¥ wE - ..
q R, s e i l‘ e :lf;}{ vy
SR gt o @0
4

Tem & oy T

Opcion Map View: Es la opcién por default. Muestra el mapa tal como lo estamos trabajando

Opcién Outline View: Despliega el mapa en el formato tradicional, es decir en forma de listado
Mostrando los archivos o ligas adjuntados.

&=

T T
o [flerersormizt vl

“Topics - s - - .- : - 2]
| Central Topic o
i Main Topic 3
| Main Topic ' A

Opcidn Multimap worspace: muesta solo el mapa que en el que se este trabajando, si estuviera ligado a otros
mapas o partes de mapas, se mostrarian en la pantalla
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el <document not saved> * . _ :
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Impresion de un mapa

Usted puede visualizarlo antes de imprimir el mapa creado desde el men( File > Print Preview.

Salvando un mapa

IBme [ . el 4B Y B
é_‘:j Y Beraaie ve
e R, ] BV ST
Hisdww LAl ey
I 1 P
@ 2Tjrstnaropt. g
S Dconweti 7] agaz . peg
© T} gt pag
% j'E* iAirdemod
~ Duak Wiabius:, vag
L :5* i

%

vy
§
5

%r;..g.m; o (T vt [N | B 3= 1

Para salvar el mapa seleccionar el men File > Save.

También puede ser salvado como imagen seleccionando Map as an Image, enviarlo a personas via correo electrénico

o expertarlo otros documentos Flo g Edt Vew Insett Top F
) tow ,
EF open . ’
. Import >
. Close Chrl+w

4 save Cuil+s

' " Save fis.., F12
éave Filtered Map as Copy...
sove

‘;ﬁ Searth Fles...

" Page Setup...

Il’;i' Prink Preview CrkF2

l&h ek, - 7 Cukes
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Conversién a formato PDF

Cuando se quiere compartir el mapa finalizado con alguien guien no tiene acceso al software MindManager,
se puede salvar el documento como un archivo en formato PDF.

Seleccionar el mend File> Export y seleccionar el formato del programa a la que se desee exportar

| " Export ¢ . *I l@ Pack and Go... |
L. E-mail »| ), POFEile...

- Securlty... o Image Fie... .

!‘ae‘ﬁ, ,)i f‘“ 3 A 1 -

; "% Properties... 1 Mujd;et MindiManager 2002

Eﬁt Alt+F4 ; Save as Web Pages. .

Microsoft Outlook Task Export. ..

: Microsoft PowerPoint Export. ..

=l

. Microsoft Word Export...
L Export toMPY..

MEW,,_

En este caso es a PDF

Guarda en. Eﬂ My Maps

P

7 History 7
€ v“‘ ’0‘

H Aoy . -
" My Documents
I (P

% Desdon

L e e
T Tee oo T R [ Cancem ]

Para hacer esto seleccionamos el men( File > Export y elegir archivo PDF. Por ejemplo si se quiere colocar el
mapa en la WEB
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R‘mem .‘"
' le3(mbatv&0rdv4x)
¢ umn(naubatvs:)
) f‘vums(mmmm

"57 rem: ’:swt‘:mu’aawm

i
i
I uteat i,
i
i
L

T e (e,

Exportar a una presentacion de Power Point

Para salvar un mapa como una presentacion de Power Point, para hacer esto seleccionamos meni File
Export y elegimos Microsoft PowerPoint export. Esto nos puede permitir planear la estructura de la lectura
en MindManager y entonces usar la presentacion exportada como una base para la lectura.

Salvar el mapa como un archivo ZIP

MindManager tiene el comando ilamado ‘Pack and Go’ que permite guardar los mapas creados con tedos los
archivos adjuntos y como un archivo autoextraible. Por ejemplo si se quiere enviar el mapa por e-mail.
Para hacer esto seleccionar el mend File > Export y click Pack and Go. Esto abre el cuadro de dialogo Pack

and Go Wizard

Welcome to the Pack and Go Wizard
Thes wazard helps you to pack your map and
docuﬂents into a single ZIP fI|B ora seh‘ extractlng EKE ﬁle

krded

LAY ‘.sw

):_f“iteplnfaz . Mﬂfksdoyouwanttuaddtothcapmdm? o
@Mdmaponly(m&*:ddocurmnrs)

P
a0
GaERE

o Slezt Al )

._.L. _..f_._....u..-_..m..m

¢ W h
,~§ " Oesed Al

l‘;nﬂh

U7 nked divents:

L Lt x w)inlwd'm ;n'm's

e G

G.Go Wigard__

Welcame to the Pack and Go Wizard
Thus wizard helps you to pack vour map and optionally knked
documents Into a single ZIP flle or a seif-extracting EXE file,

Step 3 of 3 Protect added files by standard ZIP password.

[jfnabla passw:rd pruta:tlan

i Aih |k)s-»-:) d

————

Passwur\:l‘: "

;{ <atrés || Fmaizer | [ “Concelar

8
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Timer

Es una herramienta que proporciona el programa para cronometrar la duracion de las reuniones o actividades
que estan involucradas las sesiones de trabajo.

iIc:::ul_{l" Window- Help,” ) : ’

3 f

; 5% speling... F7
Language...

! @" Reparr Broken File Hyperlmks...

I . Wizard Customization. . .

!fiﬁ Start Brainstorm
‘B3 Start Revew .

II S 1 S T T U SR || B : Show Timer

i -

i " Topic Aetts... . . 5 Minutes

i . -

t ., Template Qrganizer... © 10 Minutes

P . : 15 Minutes

j, Macro » ’ =

; ' addins... ; 20 Minutes
i . <% 30 Minutes

i . Transformations. .. ] .

i Package Folders. .. s 15 Minutes

P ‘ " 60 Minut

L 3#L AutoCorrect Options. .. . Ghinues

n un clic sobre él se introduce el tiempo de duracién del evento.

Brainstorm (Tormenta de ideas)

La funcién Brainstorm facilita ia captura de nuevos temas. Los principios son los siguientes:

o Permite registrar las ideas rapidamente y entonces agrupartas. Cuando usted ha terminado la sesion del
brainstorming usted arrastra los topicos resultantes al mapa.

o Una sesion de brainstorming puede usarse al empezar un nuevo mapa y para desarrollar los nuevos temas
para mapas existentes. Mientras la mayoria de las 6rdenes funcionan todavia, el objetivo principal consiste en
construir un mapa usando la herramienta para la agrupacion y registro de ideas. La anotacion adicional y

codificacion pueden completarse cuando usted devuelve a la vista del mapa normal. Para

Para comenzar una sesion de Brainstorm:

1. Seleccionar el menu Tools - Start Brainstorm. Activar Timer
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Tools Eﬂindow‘ ﬂelp-T-:T_ti SR

2 speling... . F7
+ Language...
&% Repair Broken File Hyperlinks. ..

Wizard Customization. ..

i

[&}ﬂ Start Brainstorm - - 7 ]

2. Laventana de Brainstorm se abre. Observar que el botén End Brainstorm se encuentra en la esquina

superior derecha.

L RN S ARbe sy @Rro i ene sac o w:de ff 83

:S(tup Z.Defne groups to pr;urj‘gwlze : ' Stcp 3 Drag your ideas from the left to the gruup

T4 % topes onthanight. ThenFnshBrams:nrmhq‘
~ 7 et e e gty

Paso 1: introducir todas las ideas

» Escribir cada nueva idea en el campo Enter ail your ideas: y presiona Enter o click en el botén Insert . Un
nuevo topico aparece a la izquierda de |a ventana.

+ Si se comete un error al introducir la idea , se puede corregir seleccionandola o editando el texto.

» Si se quiere borrar la idea, click en ella y presiona Del. Se pueden registrar las ideas aleatoriamente, o en

forma pausada para luego agruparlas, y enseguida escribir mas ideas.

Paso 2: Definir grupos para priorizar.

1. Seleccionar Enter Group Names que se encuentra abajo de Define groups to prioritize them.

g l

C | Enbor one |
i "vellow' ; -{ Exter pane i
‘ Green ; Enter ranne ;
e |
{:3 violet: i Ertecrame oo |
' [ ok} [ concal )

2. Introducir los nombres de todos los grupos que se necesitan (Usted siempre puede crear o remover

grupos) entonces seleccionar OK. El grupo topicos aparece con el nombre de los grupos como subtopicos
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Paso 3: Arrastrar las ideas de izquierda al grupo de topicos la derecha.

4

+ Arrastrar y soltar cada idea en el grupo correspondiente.

Usted puede resumir las ideas, o puede adicionar subtdpicos directamente a las ideas agrupadas para
agregar mas detalles. También puede arrastrar y soltar dpicos para reorganizarlos cuando sea necesario

durante la sesion.
Para finalizar la sesion brainstorming:

Click en el botén End Brainstorm Usted observara los resultados en el fondo del mapa.

2. Arrastrar y solfar la sesion de tormenta de ideas en el mapa principal.

] s T S T PRt p
+ i

Enkter search text

i

i Step 3 Drag vour ideas from the left to the group i

&

- topics on the right. Then Finish Brainstorming
and copy the results into the map.

CEL e e - S

Todo acerca de las plantillas

Usted puede cambiar la apariencia total de su mapa modificando e! estilo directamente o aplicando una
plantilla de estilo (un conjunto de parametros del formato pre-definidos). Tipicamente, usted entrara en su
contenido primero, determinard el formato predefinido modificando el estilo o escogiendo una estilo de
plantilla y entonces el formato de los tdpicos individuales como sea necesario. Una manera rapida de

reproducir el formato de un topico es seleccionando el Format Painter.

Ademas, usted puede codificar los temas con los marcadores (los iconos, color del texto y llenado) eso tiene

especial significado.

Usted puede:

o Aprender acerca de estilos

. Cambiar el estilo por default

. Aplicar estilos de plantillas

- Administrar estifos de plantillas

Aplicas estilos individuales de letras a los diferentes topicos
. Aplicar formatos de forma y color a los topicos
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Usar las plantillas de estilo

La apariencia global de un mapa esta determinada por los estilos predefinidos de acuerdo al contexto. Un
estilo es una coleccién de caracteristicas predefinidas usadas para distinguir los varios tipos de elementos

que contiene su mapa.
Cuando usted agrega un nuevo objeto del mapa, su apariencia es determinada por el estilo definido que

contiene el mapa.

Las caracteristicas necesarias para definir un estilo son las siguientes:
Topico central, topicos principales y subtopicos( por nivel)

L.a organizacién de fos topicos principales y subtopicos

Los topicos especiales {callout)y sus subtopicos

Topicos flotantes y subtopicos

Estructura de los Topicos flotantes y subtépicos

Agrupaciones de los Topicos flotantes y subtopicos

Relaciones

Fondo del mapa

Notas {tipo de letra predefinida)

Personalizar MindManager -

Personalice la interfaz

El menu Tools - Customize — Options le permiie a usted ajustar la apariencia y funcionamiento de MindManager.

o e e o e e+ 15
Tools I: window Help : 4 .. -. ;
‘,'}" Speling... _ F7

Language...
@33& Reparr Braken File Hyperlinks. ..

Wezard Customization. ..

L

JA Start Branstorm®
pr— |

= Start Review

, Timer . 4

Topic Alerts. .,

Template Organizer...

' Macro 4
© Add-Ins...
Transformations. ..
Package Folders...
¥ AutoCorrect Options...
I.-ﬁ Customize, .

. Qptions...

Las opcidnes de menus personalizados pueden controlar la forma en que se despliegan los mismos.
+ Always show full menu muestra todos los comandos cada vez que se usa el mend.

* Show full menus after a short delay muestra solo las ordenes que se han usado en forma reciente
primero y entonces todos los comandos después de una pausa. Los comandos que son desplegados
dependen de la frecuencia de uso que es registrada por MindManager. y solo mostrara las ordenes de mas
reciente uso. Esta opcion puede ayudarnos a encontrar mas rapidamente los comandos que con mayor
frecuencia se usan,

» Clic Reset my usage data para restaurar los comandos que se encuentran visibles por default.
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Otras opciones de control:

Si se usan botones grandes en las barras de herramientas, que tipo de ayuda son desplegados en la
pantalla y como los comandos se mostraran,

Toolbars

Para desplegar o esconder las barras de herramientas, desplegar el mend contextual en cualquier barra de
herramientas entonces deseleccionamos las herramientas que no queremos ver en la pantalla. Inicialmente
se despliegan cortadas en el fondo de la pantalla o en la parte superior. Para que la barra de herramientas
flote en la pantalla seleccionarla y arrastrarla a otra parte, enseguida soltarla.

[Z Standard
E Map
[Z Farmatting
E Exporkt
[~
[~

Advanced Formatting

Rewview

y Customize...

. . 3 .

Para utilizar las barras de herramientas en modo perscnalizado Clic Customize. Se pueden quitar o agregar
comandos de las barras de herramientas y de esta manera controlar lo que se quiere ver.

Para agregar botones a las barras de herramientas:

1.- Seleccionar cualquier barra de herramientas y presionar con el boton derecho del raton para desplegar el
menU contextual seleccionamos Customize o Tools - Customize. Seleccicnar la pestana de Commands.

2 - La pestafia despliega una lista de las categorias de comandos en la izquierda con los botones asociados a
la derecha. Se puede observar que hay una categoria para cada una de las barras de herramientas, pero se
puede agregar botones de cualquier barra de herramientas.

bars Cummands 1 o

<dd, or delete trofpar butrons ard menu comenands ——— - ——vaea - -
Categones:

Py
‘Edit :
“vew

Descrption: © 7 CLegp, o
e e

*
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3.- Presionar en el nombre de una categoria. Arrastrar cualquier botdn del area de comandos a a la barra de
herramientas que se desee agregar el boton. Para los menls que contengas subcomandos se puede agregar
al principal mena .

4 - Cuando se termine de agregar o eliminar botones, entonces clic OK

Para reorganizar botones

Cuando la caja de dialogo este abierta del meni Tools — Customize, usted puede seleccionar y arrastrar
cualquier boton para ajustar su posicién. Puede incrementar el espacio entre Iso botones o cambiar el orden
en que se encuentran en la barra de herramientas.

Para seleccionar un separador entre dos botones simplemente desplegar el men( contextual y seleccionar
Start Group.

Para crear una nueva barra de herramientas

* Arrastrar y soltar el boton que se quiera del cuadro de dialoge Customize - Toolbars a un espacio en
blanco en el area de barras de herramientas. Para regresar a la configuracion original de Ia barra de
herramientas, hacer los siguiente:

Clic Tools - Customize — Toolbars y clic en el boton Reset

Seleccionar Tools — Options — Save bajo la aplicacion

hvanced Formatting -
[#iExport

[iFormatting

V]Map

[ [T WY Y

Hay que tener cuidado al resetear todas las barras de herramientas y opciones de ventanas contestar si, se
esta seguro. Al reiniciar el programa se mostraran las barras de herramientas originales.
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assword protecton opticns - s
g;tma’ Delete & stored passwords: 1.
Yisual Effects L T o
Save Bitichwents it
User Iformation — |* 11 shewe war
Notes e
Speling

Topic Alerts
Review
Bicecuizy D

Cuadro de dialogo del comando opciones

Complementos, transformaciones y macros

Complementos

MindManager cuenta con un conjunte de complementos preinstalados que extienden la funcionalidad basica
del programa. Esos modulos de software agregan comandos a la interface y aparecen como parte integral
de la aplicacion.

Las aplicaciones de Microsoft Office importan y exportan las caracteristicas, numeracion y ordenacién de topicos, exportan
caracteristicas Web, partes inteligentes de mapas etc. Todo esta contenido en los complementos. Mismos que son proporcionados
por MindJet o por terceros. Pueden ser habilitados en el meni Tools

[AfBmerc Mo Ports (ve0.6as) &l
[#]5ort Topics (v6.0.643) i
[¥]5ave as Web Pages (v6.0,643) [ -
[¥]Merosoft Excel binker (v6.0.643) ko
[w]Merosoft Outlook Task Import and Export {v6.0.643)
[¥]Mcrosaft Cutlook Map Parts (v6.0.643) -
[¥]Mcrosoft PowerPornt Export (v6.0.643) A
Click on the bex next to an add-in name to enable o disable it :
Destrpbirt: = - o i —_—
- T
Locaton: ' £ 1. I S DU,
i‘ B ; . s
_— e RN B
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e i e e s i

[Tooks | sindow _tep =L~ |

% Speling... F7
Language...

f-‘? Repair Broken File Hyperinks. ..

57 start Branstorm
B SartReview

. Timer T

T
i

! Topic Alerts...

7 Template Organzer...
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Transformaciones

Transformaciones permiten la conversién de un mapa a un formato de texto o vice-versa. Como los
complementos, las transformaciones agregan comandos a la interface de MindManager y aparecen
infegrados. MindManager Pro proporciona dos transformaciones (accesibles desde el ment Save as del
menu Save}, al convertir los mapas a formato de texto. Se puede elegir Outlines - Plain Text a crea un
archivo plano y Qutlines - Web Page que crea un archivo en formato HTML. Adicionalmente

Pueden ser desabilitadas en el cuadro de dialogo Tools - Transformations

[F10utines - Plan Text
[Vjoutlines - Web Page

Click on the hox next tg a transfrmation name te enable or disable it . ..,

¥

L. ;
N b . o o wj‘:; ,
' ‘ “ b=
Flefels” ex
| ) - o Z
= ,‘ff kkkkk —

INSTRUCTORA: LIC. NELVA E. EHRLICH QUINTERO -50 -



UNAM CURSOS INSTITUCIONALES DECFI
“MIND MANAGER”

Macros

Funciones adicionales pueden ser proporcicnados por el uso de macros de MindManager. Difieren de los
complementos por que no son aplicaciones separadas: son un conjunto de comandos que MindManager
utiliza para realizar ciertas acciones. Pueden ser proporcionados por terceros o ser creados tambiéen
utilizando el editor de macros preporcionado por MindManager.

Se modifican, agregan y borran con las opciones Tools - Macro — Macros.
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i

Add new News Feed to Library..,

Transformations...
§ .

B Tty

* Click Tools - Macro - Macro Editor.
El editor tiene incluido su propio archivo de ayuda accesible desde la barra de herramientas del editor

Fio Eﬂt_\rew Macro Debuq Sheets Help . o
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Mas soluciones

Usted puede obtener macros, transformaciones y complementos de terceros de la pagina Web de
MindManager, Haciendo Click Help - Mindjet MindManager Community.

Create Map Wizards

Wizards son convenientes, ya que es una manera rapida para cualquiera para introducir informacion a un
mapa. Ellos pueden simplificar la construccion de mapas complejos de tal forma que los usuarios casuales
puedan introducir informacion rapidamente. También aseguran que la estructura del contenido de los
contenidos de los mapas sean consistentes. Los Wizards puedes ser adicionados a las platillas de los mapas.
Cuando un usuario crea un nuevo tipo de mapa de una plantilla, el Wizard se ejecuta automaticamente,
seleccionandolos para introducir la informacion requerida(los usuarios pueden deshabilitar un wizard para una
plantilla en el organizador de plantillas en la Template Organizer - Map Templates). La personalizacion es una
opcién avanzada que puede ser usada solo por usuarios avanzados de MindManager.

Creacion de un wizard- Pasos asicos

Hay muchas posibilidades para crear wizards que va desde el mas simple hasta el mas complejo. Las
siguientes instrucciones ilustran los procedimientos basicos para crear un wizard para una plantilla de mapa.

1.Crear el mapa que sera usado como plantilla, El wizard recolectara la informacion comenzando con los
topicos de la zona superior derecha y en sentido de las manecillas del relog.

2.Seleccionar Tools-Wizard Customization para empezar a crearlo. Usted podra permanecer en este modo
hasta que haya finalizado la creacion del wizard O regresar a el hasta que haya agragado 0 modl‘r” cado Ios
aquellos que ha creado. o « T

CoTTTTTT LT Page settngs

Tools | Window Help - i —_— -
e : : O }io wizard page | )
v Spelling... ) ) F7 (}Addtoprewouswzarda e ¢
’ ! I;anguage...- ONew unzardpage .t '
: . . . ka&i:g . I
&2 Repair Broken File Hyperlinks... Coscritoen |
! © Wizard Customization...- . - z P . o

# -
R AN e - P

[ lteoembegs e

3. Seleccionar un topico para la primera pagina del wizard o L
(usualmente un tépico principal con subtopicos). tepedats ey T ¥
4 Bajo Page Settings New wizard page e introducir ef
encabezado y una breve descripcidn que desplegara cuando .
el wizard se ejecute. Esto sucede cuando se agregan | -————mimemmeen et pnesines o co
comentarios acerca de Is datos introducidos. CL i (o= ]
5. Si usted eligid la opcion "No data" solo serd usada para - - - —
desplegar las opciones para los subtdpicos. Si se desea que la pagina reuna los datos de para este tépico
elegir Data type e introducir texto para esta pregunta. Cuando el wizard se ejecuta los datos que el usuario
introduce como una respuesta reemplazara el texto del topico.{ Si se quiere mantener el texto original y solo
obtener una respuesta seguida agregar : al final del texto del topico en el mapa).

S et [ |

I(‘_cntral Hoco

6.5eleccionar un subtépico y aplicar la opcidn Page sttings para Add to previos wizard page. Esto significa
que el usuaric seleccionara los datos en la misma pagina usada por el iépico anterior( en este caso el
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pariente). Una pagina wizard solo puede pedir tres respuestas a la vez, pero las repetira hasta que todas las
respuestas de los subtépicos hayan sido recolectas.

7.Elegir el Data type e introducir algin texto para la pregunta

8. Continuar con otros subtopicos de la misma manera, agregandolos a la pagina previa del wizard.
Entonces moverse a otro topico principal y los subtdpicos de la misma manera( creando New wizard
paginas para los tdpicos parientes a paginas adicionales para los subtdpicos) Usted no necesita recolectar
datos para cada topico. Puede regresar a las opciones del wizard del tépico seleccionandolo otra vez.

Referencia de abreviaciones del teclado
Documentos de mapas:

Accion abreviatura
Crear un nuevo mapa Ctrl+N
Abrir un mapa Ctrl+Q
Salvar €] mapa actual Ctrl+S
Salvar como F12
Cerrar el mapa actal Ctri+W
Impresidn preliminar Ctrl + F2
Imprimir el mapa atual Ctri+P
Navegacion:
Accion abreviatura
Select topic above, below, Arrow keys
left or right
Select next topic / previous | Tab / Shift+Tab
topic
Move to next / previous Ctri+< / Ctrl+>
bookmark
Visualizacion:
Accién abreviatura
View Next Map Ctrl+F6
Ajuste horizontal del mapa Ctri+Alt+S
Ajuste vertical del mapa Ctrl+Alt+V
Mostrar/esconder las notas en | Ctr+T, F11
la ventana
Ver la siguiente/note de texto | Ctrl+Shifi+PgUp /
previa PgDn
Ctri+Arrow keys

Desplazarse en la pantalla a
pasos pequenos

PgUp, PgDn (up

Desplazase en la pantalla a and down},
grandes pasos Ctri+PgUp,
Ctri+PgDn {left
and right)
Ajustar el mapa a la pantalla Ctrl+F5
Visualizacion
Accion abreviatura
Centrar mapa Alt+F3
Toépico principal F3
Aumentar tamaiio de mapa Ctrl + =
Disminuir tamaiio de mapa Ctrl + -
Mostrar el sigueiente nivel Ciri+D
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Mostrar nivel 1

Shift+Alt+1

Mostrar nivel 2

Shift+Alt+2

Mostrar nivel 3

Shift+Alt+3 ..etc

Colapsar tépico

{up to level 9)

Mostrar el topico entero Shift+Alt+A
Colapsar topico Shift+Alt+0
Remover filtro Ctri+Shift+Alt+A

Edicion:

Accion

abreviatura

Selecionar todos los tépicos

Ctri+A

Aseleccionar tépicos

Shift+arrow keys

adicionales
.| Mostrar todos los parientes Ctri+Shift+A

Solo el siguiente Shift+End

Solo el anterior Shift+Home

Seleccionar todos los Ctri+Shift+left

subtopicos arow

{Solo en el siguiente nivel) Ctri+Shift+right
arrow

Seleccionar todos los topicos | Shift + F3

en los niveles(all levels)

Borrar formatos Ctri+Space

Copiar del portapapeles Ctri+Insert
Ctri+C

Cortar del portapapeles Ctri+X
Shift+Delete

Copiar contenidos al Shift+Ins

portapaples Ctrl+V

Copiar llamadas Ctrl+Shift+Vv

Deshacer la ultima accién Alt+Backspace,
Ctrl+Z

Repetir la Gltima accion Ciri+Y

Moverse al comienzo de la Home

linea

Moverse al comienzo del texto | Ctri+Home

del toépico

Editar el texto del topico F2

Introducir interrupcion de Ctri+Enter

topico

Moverse al comienzo de la Home

linea

Moverse la final del texto del | Ctrl+ End

topico

Encontrar Ctd + F

Borrar topico u objeto Delete

Remover el tépico Ctri+Shift+Delete

seleccionado

Move to end of topic text Ctri+ End

Replace Ctrl+H

Mover topico: hacia arriba un | Ctri+Alt+Up

lugar arrow

Hacia abajo un lugar | Ctri+Alt+Down
arrow

Al principio Ctr+Alt+Home

Al final Ctrl+Alt+End

Borrar todas las posiciones Ctri+Alt+Space
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